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VERSION 1.4.0

NEW FEATURES:

Product Support:
+ Added support for SRX912M, SRX915M, SRX922, and the SRX922 Array Frame in Venue Synthesis.

Enhanced Multi-core Performance:
+ The Venue Synthesis acoustic engine (ACE) has been significantly optimized to leverage all available CPU cores, improving overall
calculation performance.
+  Previously, ACE utilized only a single CPU core, regardless of the number of cores available on the system.
+  The new multi-core architecture can deliver dramatic calculation speed improvements on most systems, with performance gains

scaling proportionally to the number of available CPU cores.

New View Menu for 3D Space:
+ A new View menu has been added to provide centralized control of 3D space display settings.
+ Options include toggling the Axis and Grid on or off, along with other viewport controls.
+ Options such as Transparency Mode and Show/Hide Audience Areas have been moved from the 3D space title bar to the new
menu.
+ New options are available to show or hide items such as SPL Flags, Delay Flags, and Tape Measure distances, allowing these
elements to be temporarily hidden in the 3D workspace without permanently removing them.

+ The new View menu can be accessed using a button located at the top-right corner of the 3D cube.

Plane Color Customization:
+ Added an option in the new View Options menu to switch plane coloring from Type to Tag Color. When enabled, planes inherit the
color of their assigned Tag. Planes without an assigned Tag use the Untagged color.

+ This feature allows venue models to more closely reflect real-world color schemes for improved visual clarity and presentation.

Plane Transparency Options:
+ Planes automatically adjust transparency based on camera position and orbit settings, allowing users to view inside a venue with-
out hiding or deleting exterior planes.
+ A new option has been added to override this behavior on a per-plane basis when transparency is not desirable. Objects such
as video screens, trusses, stages, chairs, and other scenic elements can now remain solid regardless of the camera viewpoint.

+ This setting can be enabled or disabled per plane or per Tag from the Properties panel.

New Pen Tool Functionality:
« The Pen Tool can now draw directly on any imported image, regardless of its position in 3D space.
+ Previously, drawing was limited to Origin Planes, typically requiring images to be placed at Z=0 for tracing, with planes reposi-
tioned afterward.
+ Now, images imported at any elevation (for example, a balcony floor at 3 meters) can be traced directly in place, eliminating the

need to draw at Z=0 and move geometry later.

IMPROVEMENTS:

+ Venue Synthesis now supports per-monitor DPI awareness on Windows for improved scaling and sharper Ul rendering across

multiple displays.
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Tape Measure improvements: Distance measurements are now retained between views and modes, similar to SPL Flags. Mea-

surements can be cleared using the right-click menu.
Venue Axis snapping: The venue origin axis can now be used as a snap point when using the Tape Measure tool.

Mechanics Mode - Distributed Subwoofer Arrays: Distance flags used to display physical measurements of distributed subwoofer

arrays are now rendered as vector graphics, preventing pixelation when zooming in or out.

Home Screen performance improvements: Project thumbnail loading has been optimized, allowing the Home Screen to load fast-

er, especially for users with large project libraries.

Circuit Grouping update: When Circuit Grouping is set to Custom, all existing circuit groupings are automatically removed, elimi-

nating the need to manually ungroup circuits.

Calculate button update: After a mapping calculation is completed, the Calculate button changes to Clear. Selecting Clear re-

moves the calculation color overlay.

Improved Mechanical Error visibility: System Group text now turns red when a mechanical error condition is present, providing

clearer visual identification of mechanical errors.

Headroom Indicators: Headroom LEDs in front of System Groups now flash on and off when a system group is in gain reduction,

drawing more attention to limit states.

ARM64 compatibility on Windows: Venue Synthesis is now compatible with Windows 11 ARM64 devices using emulation. Native

ARM®64 support is planned for a future release.

Fixed an issue where coverage cones of point-source speakers were rendered incorrectly when horn rotation or roll parameters

were applied.

Fixed an issue where Headroom Flags did not clear after changing mapping options.

Fixed an issue where zoom level changes affected the dashed-line spacing of Tape Measure distances.

Fixed an issue where Corner Point properties disappeared from the Properties panel after deleting a corner point.

Fixed an issue where dragging the Autosplay start marker caused it to move to the opposite side automatically.

Fixed an issue where an SOC object disappeared from the workspace when adding points from the Side Cut view.

Fixed an issue where imported images were not set to 100% opacity by default, causing them to appear faded after import.

Fixed an issue where venue parameter values did not update immediately after switching units (e.g., from ft/Ib/°F to m/kg/°C) and

selecting Reset Unit Settings.
Fixed an issue where the order of duplicated SOC objects was not maintained after duplicating the main SOC.
Fixed an issue where the Pen Tool would sometimes not exit when pressing the Esc key.

Removed the Suspension Mode option from systems that support only a single suspension mode.
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+ Fixed a bug that caused mechanical errors when VTX V20 was set to Compression mode.
+ Fixed an issue affecting the array-mirror function when group rotation was applied.
+ Fixed an issue that could cause the Ul to display a blank white page under certain conditions.

+ Updated the minimum supported macOS version to 12.
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NEW FEATURES:

Speaker Coverage Mapping:
+  Within Acoustics Mode, loudspeaker coverage can now be mapped using the new Coverage Plotting method.

+ For individual loudspeakers, the horizontal and vertical coverage represents the product’s -6dB acoustic down point. For line
arrays, the vertical coverage shown reflects the combined splay angle of all array elements.

+ The color of each loudspeaker’s coverage plot matches the color assigned to the System Group from the Grouping Panel.

Improved 3D Import/Export Engine:

+ The 3D import/export engine has been rewritten from scratch to allow additional 3D file types to be imported and to improve the
engines ability to handle complex DXF files with high polygon counts.

+ In addition to the DXF, GCF, CAD, and XFC formats previously supported, DWG and 3D PDF files can now be imported and Loud-
speakers can now be exported in DWG format.

+  Complex DXF files that previously failed to import into Venue Synthesis should now load without error.

Updated Navigation Controls:
+ The original 3D Gizmo at the bottom right corner of the Venue Workspace has been replaced by a new 3D Cube.
+ The 3D Cube tracks venue orbit and allows for easy selection of a standardized set of 2D and 3D views. Clear labeling and a re-
sponsive Axis Indicator makes it easier for operators to orient themselves in the 3D space.

EASE Integration:
+ Venue Synthesis is now able to export EASE XLD files as well as the previously supported EASE XGLC format.

+  Within the EASE ecosystem, an XLD file defines each speaker as it relates to the overall venue (Position, delay, etc) whereas the
XGLC file defines each loudspeaker object (humber of elements, splay angles). The two file types are designed to complement
each other when transferring a complete system design from Venue Synthesis to EASE.

New Group Functionality:

+ A new Spacing Method control in the Layout tab lets users choose between Center-to-Center or Edge-to-Edge spacing for Dis-
tributed Subwoofer System Groups.

+ The Axis Alignment switch in the Layout Tab has been replaced with a Group Rotation control, allowing you to rotate the entire

System Group to a specific angle—especially useful for positioning side or rear groups in immersive setups.

Advanced Headroom Calculations:

+ When hovering over a Headroom Indicator the headroom of each array or circuit is now displayed for each bandpass.

+ Headroom will now show both positive and negative values for each bandpass. Positive numbers represent headroom remaining
while negative values will continue to show gain reduction.

IMPROVEMENTS:
+ Venue Synthesis now runs natively on Apple Silicon Macs with no Rosetta translation required.

+ Tag Groups can now be isolated in Venue Mode from the Tag Group Panel. When a Tag Group isolate is active, only Planes as-
signed to that Tag Group will be displayed in the Venue.

+ A new General Application Setting allows operators to reference the Z Bottom of Suspended Arrays when setting the height.

+ Quick links to expose relevant settings from the Settings Window have been added to the Environmental and Mapping options
displays, as well as the Group Position field in the Properties Panel.

+ A new Venue Selection option in the Delay Finder lets operators enable all System Groups at once.

+ A Rectangular Lasso Tool has been added to the selection options in Venue Mode. The L key will enable the most recent selection
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tool used, SHIFT + L will swap selection tools.

Warped (non-coplanar) planes are now automatically triangulated during import to prevent invalid geometry errors.

A new flyout menu in Mechanics Mode displays precise coordinates when hovering over speakers and accessories.
The application will now recall the previous window size after quiting and reopening.

Windows: all standard operating system windowing functions are now supported.

Circuit colors now follow the resistor color code standard in both Venue Synthesis and ArrayLink.

Zooming in or out now follows the mouse pointer and the zooming range is no longer limited.

Settings affecting the application and settings affecting the project have been clearly split in the Settings Window.
Crosshairs have been added to the Tape Measure and Pen tool in 2D views making it easier to accurately align points.
The Tape Measure will now snap to arrays and venue geometry in Acoustics Mode.

The Hamburger Menu has been redesigned to align with the JBL Performance application.

Selecting the title text of a section in the Properties Panel will now open and close that section. .

Several general Ul improvements across light and dark modes have been implemented.

The order that QR codes are displayed in Mechanics Mode now matches the order of Groups in the System Group Panel.
SPL and Delay Spread Flags can now be individually removed by right clicking on them.

The color of System Groups is now set by right clicking on the Group in the System Group Panel.

Added support for localized decimal separators in numeric input fields.

Resolved multiple problems with the DXF import feature preventing some complex DXF files from importing successfully.

Resolved a problem where the Autosplay algorithm was malfunctioning for V25-II systems outfitted with VT4889 AF and VTX4889
SF array frames.

Made it easier to add a Probe to a listening plane in the 2D Measurement graph.

Repaired numerous small bugs related to the list of recent actions displayed in the Undo Button dropdown.

SRX918SF is now able to be used beneath SRX906LA in a ground stack.

Fixed a bug in the “Average Arena 360” example file that would prevent it from being imported into Performance Manager.
Fixed a bug that would enable speaker Rays after adding a new System Group or saving the project.

Fixed a bug affecting the ability to hide or show geometry imported from a DXF file drawn containing blocks.

Fixed a bug that would intermittently display Ray controls when right clicking on a Tag in Venue Mode.

Fixed a bug that would prevent Special Objects mirrored from duplicated geometry from being listed in the Special Objects Panel.
Fixed a Ul bug that would on occasion display the 3D Gizmo control behind the Delay Optimizer results.

Fixed a bug allowing a pullback frame to be selected on VRX900 arrays with single point suspension selected.

Fixed an issue where System Group colors were being re-used after restarting the application.

Other minor bug fixes.
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Fixed an issue where SPL mapping calculations were not correct when SRX900 and passive speakers were used as part of the
same design.
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Product Support:

+ The new SRX900 flyable subwoofers have been added to Venue Synthesis. The new subwoofers can be used in standalone sus-
pended configurations, in mixed arrays with SRX900 line arrays or in mixed and standalone ground stacked configurations.

Signal Generator:
+ AES75 (Music Noise) is now an option for SPL mapping. AES75 has a unique spectral shape that better represents music, when
compared with to Pink Noise.

+  C-Weighting is now available for supported signals.

Tags in Venue mode:

+ Tags in Venue mode are used to organize geometry into logical groups. New functionality has been introduced to Tags, simplifying
the process of creating and assigning Tags. Once a plane is selected, the keyboard shortcut Ctrl + T (or CMD + T) can be used to
create a new Tag and automatically assign the selected planes to the Tag. Alternatively, a new Tag can be created from the Tag
drop-down menu.

Auto Plane Orientation Tool:

+ In Venue Synthesis, planes have inside and outside faces. The outside face turns transparent when viewing the model, letting
users see inside a closed venue without hiding planes. Sometimes, the faces are assigned incorrectly when importing venues from
3 party applications.

+ A new tool has been added to Venue mode to help automatically orient planes. The tool works by computing the midpoint of the
selected planes and then sets all planes to face that point.

+ To use the new tool, start by selecting a number of planes, then right-click and choose the Auto Plane Orientation option.

Move Tool:
« The Move tool in Acoustics mode now works for multiple selected System Groups, making it easier to move an entire system to
a new position.

+ To use the Move tool, select all arrays to be moved and then choose the Move tool from the Tools drop-down menu (keyboard
shortcut “M”).

Lasso Tool:
+ The new Lasso tool in Venue mode simplifies multi-selecting planes. It allows drawing a freehand selection area to pick specific
parts of the model, like catching elements with a virtual lasso.
+ Activate the Lasso tool from the Select tool drop-down menu or using the keyboard shortcut “L”.

+ Dragging left to right selects only objects fully within the lasso. Dragging right to left selects anything the lasso touches.

User Interface:

+ A new light theme has been added to help improve visibility in bright environments and can be selected from the application set-
tings. When “System” is selected, Venue Synthesis follows the theme set by the operating system. Note that projects displayed
on the home screen will retain a dark background and will not follow the theme selection until they are saved again in the new
version of Venue Synthesis.

+ Several other improvements have been made to the application to improve user experience and better align with the JBL Perfor-
mance application.

Speed and Performance:

+ After significant code optimization, the application is now much faster. Large venues with thousands of polygons render smoothly,
and importing large 3D files is over 10 times faster. Please retry using large venue files that were previously challenging.
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You can now disable the boundary plane for distributed subwoofer arrays. This feature is useful when distributed subwoofers are
not on the ground.

The import file progress bar now displays the real-time progress when importing large files.

Holding down the shift key now facilities drawing straight lines with the pen and tape measure tools. Drawn lines can snap to 45
degree increments while holding shift. The new functionality can also be used when defining the scale of imported images.

Mirror functionality is now available in acoustics mode for System Groups. Mirror creates an exact copy of the selected system
group across the chosen axis.

The Tape Measure tool is now available in all 2D modes.
An option to select 1 dB color steps has been added to SPL mapping in Acoustics mode.

In Acoustics mode, the Mute controls in System Groups can now detect a mixed-state condition. When this happens, the Mute
buttons will turn orange.

The Mute buttons under System Groups in Acoustics mode are now always visible, independent of the Mute state.
When a double-click is used on a text box, the text is now highlighted and ready to receive text input.

The Pen Tool plane orientation can now be set in the Application Settings.

Resolved additional problems with the DXF import feature preventing DXF files from importing successfully.
Resolved a problem which would cause the Autosplay algorithm to malfunction.

Addressed an issue related to the arrays frame options for A8 .

Fixed an issue where geometry could change after saving and reopening a file.

Addressed several QR code related issues.
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FLUX:: SPAT Revolution Integration:

+  SPAT Revolution’s speaker editor now supports direct import of Venue Synthesis .vsyn files in version 24.07 or newer. This addition
enables the import of active speakers from Venue Synthesis along with optimization for speaker arrangement, including planar
normalization across different loudspeaker elevations.

+ The Venue mode toolbar now includes a SPAT Revolution Reference tool (Venue > Add > SPAT Revolution Reference), which pro-
vides a customizable reference point called the SPAT Revolution reference to position the loudspeakers within SPAT.

+ This new feature accelerates system design and simplifies the creation of immersive systems using Venue Synthesis and SPAT
Revolution.

Support for AE Compact (AC Series) speakers:
+ The AE Compact speakers have been added to the Venue Synthesis speaker library.

+ Horn type and orientation can be defined within the properties panel for applicable models.

Off-axis cut views in 2D modes:

+ A new switch has been added to the 2D array cut views, allowing you to view the off-axis geometry of the chosen array. The user
can adjust the opening angle, which is preset to match the coverage angle of the loudspeaker model in use (such as +/- 45-deg
for A12).

+  When activated, off-axis geometry is shown in the 2D workspace and two SPL over Distance graphs are generated, one for on-ax-
is and one for off-axis.

+ This new feature is useful when trying to determine the necessary array “over-shoot” to cover off-axis areas. It can also help de-
termine if cabinet splay angles are appropriate for both the on-axis and off-axis coverage of an array.

Support for lines in 3D geometry import:
+ Support for line segments has been added to the DXF import feature. This will be particularly beneficial when importing 2D draw-
ings that are created using programs such as AutoCAD and Vectorworks.

+ Line segments are grouped based on their layer assignments within the imported DXF file, and the start and end points can be
used as “snap” points for the Pen Tool to draw 3D planes.

EASE GLL Export:
+ Export EASE XGLC functionality has been added for supported products.

+ Access the “Export XGLC” feature in Acoustics Mode from the hamburger menu in the System Groups panel.

3D Loudspeaker export:
+ The enhanced 3D loudspeaker export feature now offers customizable settings for DXF output files, such as setting the level of
detail, choosing units, and layer grouping.

+ Find the new feature in Acoustics Mode by going to the hamburger menu within the System Groups panel.

Home Screen Improvements:

+ Right-clicking any recent project on the home screen now brings up a new context menu. The menu offers options to show the
project in its folder, remove it from the recent list, or delete it.

Status Indicator in Mechanics Mode:

+ Mechanics Mode now includes a new Status indicator reflecting the mechanical condition of each array. Prior to version 1.1, this
information appeared under the Array Safety Factor field. The Array Status and Array Safety Factor are now represented as two
separate parameters.
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The 2D SPL over Distance views have been updated with a new mouseover feature. When hovering over the SPL graphs, a marker
will appear in the drawing view indicating the corresponding cabinet for that section of the graph.

The Special Object Creator (SOC) automatically assigns the plane type as either Architectural or Audience based on the angle of
the plane. Nearly vertical or inverted planes default to Architectural. You can also assign the plane type to a whole segment by
right-clicking the segment line in the SOC interface.

The QR code display will now only show QR codes for System Groups that are visible and not hidden.
Incorporated a hover feature on the SPL color bar within Acoustics Mode to show the maximum SPL value throughout the venue.

The right-click context menu for System Groups has been enabled in 2D modes. Options such as “Rename” and “Copy Position”
are now accessible.

Horn rotation information for point source speakers has been added to the exported PDF Rigging Manual and the QR code for
ArrayLink.

The Examples Library has been updated with a new project file that demonstrates the integration of Venue Synthesis with SPAT
Revolution.

Revised the mechanical warnings and limits for SRX906LA and SRX910LA systems. Opening prior venue files in the latest version
of Venue Synthesis might display a mechanical alert.

Resolved multiple problems with the DXF import feature where, occasionally, DXF files were not importing successfully.

Resolved a problem where the Autosplay algorithm was malfunctioning for V25-II systems outfitted with VT4889 AF and VTX4889
SF array frames.

Resolved a calculation error for the Attachment Point Span distance when using VTX A-Series and B-Series systems with Sus-
pension Bars.

Resolved a problem where the VRX932LAP was incorrectly using the 3D file of the VRX932LA-1.

Selecting side-by-side suspension points for VTX S25 and VTX S28 now includes two Extension Bars by default.
Fixed an issue with the line thickness in the exported PDF document.

Fixed an issue where planes longer than 100 m (329 ft) would crash the acoustic engine.

The correct attachment span and weight distribution is now calculated for side-by-side suspension points.

Fixed a visual issue in Mechanics Mode related to VTX V25-1I-CS system and the lever hoist position.

Fixed an issue related to the load limits of ground stacked arrays.
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IMPROVEMENTS:

Safety factor values are now shown with increased precision (added one decimal point).

SPL and delay flags are no longer removed when Signal Generator parameters are adjusted.

Reworked the Ul in the 3D space, making it easier to differentiate the positive and negative sides of the X, Y and Z axis.
Added a message in Acoustics Mode to alert users when no audience areas have been set for mapping.

The software Release Notes are now available in the hamburger menu.

BUG FIXES:

Fixed an issue related to array frame safety factors not being correctly calculated.

Fixed an issue related to SRX918S and cardioid configurations not showing the correct rejection.

Fixed an issue where the Calculate Angles feature was not working in mixed arrays with V25-II and V20 cabinets.
Improvement has been made to the System Groups panel, making it easier to rearrange the order of groups.

Fixed an issue in SOC preventing users from right-clicking to set a plane type while Distance vs. Angle was active.
Fixed an issue where the LACP Bypass All state was not correctly transferred to Performance Manager.

Fixed an issue where imported images were named using plane numbers.

Fixed an issue where the Properties Panel for distributed subwoofer arrays covered the calculate button when opened.

Shift click to select multiple planes in Venue Mode no longer stops working after the venue has been rotated.




|

PROFESSIONAL

<S> VENUE SYNTHESIS

VERSION 1.0.1

IMPROVEMENTS:

The SPL color bar in Acoustics mode is now split into solid (non full gradient) colors when 3dB or 6dB viewing options are selected.
The SPL information popup Ul is now easier to activate when hovering over the SPL Over Distance graph.

The point resolution of the SPL Over Distance graph has been increased.

Selecting all planes in a venue is now possible using the new Select All right-click command (ctrl/cmd + a).

Press and hold the left mouse button in Venue mode to select planes that are under other planes using the new fly-out panel.
Arrays selected in the 3D space are now highlighted under Group Parameters in the properties panel.

Improved the Tag folder Ul to better show which Tags are nested within each folder.

Cabinet rays are now automatically locked when in measurement mode to prevent accidental angle changes.

The Pen Tool remains active after a plane is completed and ready to create another plane.

Improved wording in the Settings panel for complex summation mapping options (no functionality changes).

System Groups in the exported PDF document are now arranged based on user order, not the order of creation.

System Groups are now arranged based on user order when imported into Performance and Performance Manager.

Hidden System Groups are no longer part of the exported PDF document or the QR code window.

The selected Patch Size in settings is now displayed on the SPL color bar in Acoustics mode.

It's now possible to assign a Tag to an entire Special Object using the properties panel.

BUG FIXES:

Fixed an issue where the angle of the VTX A6 MF and VTX A8 MF was not correctly calculated.

Fixed an issue where the Start and Stop flags were not correctly taken into consideration for the auto-splay algorithm.
Fixed color and texture issues with some VTX Series and SRX900 accessories.

Fixed an issue where the grid lines in the SoC panel were getting larger and smaller when zooming.
Fixed an issue with VTX B15G not mapping correctly in cardioid mode.

Fixed an issue with VTX V20 Bi-Amp presets and speaker data.

Fixed an issue with SRX918S speaker data causing early limiting.

Fixed an issue with SRX928S speaker data causing high SPL calculations.

Fixed an issue with some DXF files failing to import.

Fixed an issue where planes placed on top of images could not be selected.

Fixed an issue where Tags could not be moved into a folder using drag and drop.

Updated the Venue Synthesis application icon to match the icon size of Performance.

Fixed an issue where a frequency was shown in the color bar section when Pink-Noise was selected.
Addressed several mechanical warning messages.

Addressed several compatibility issues with macOS version 14.4.

Fixed an issue related to renaming groups.

Fixed a visual issue related to the pull-back accessory position for V25-1I, A8 and A12 systems.
Fixed an issue where folders could not be expanded after a rename.

Other general bug fixes.
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